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1 About this Document 
This manual provides detailed product related information, installation, configuration and 
operation instructions for 3DLevelManager software. The manual is designed for trained 
personnel. Please read it entirely and carefully before proceeding with installation of the 
product. 

1.1 Symbols in use 
The following symbols indicate different sections of additional information as follows: 

 

IMPORTANT: An indication for additional information, tips, hints or an indication 
of helpful additional knowledge. 

WARNING: Indication of a potentially dangerous situation, which could result in 
serious injury to persons and/or damage. 

1.2 For your safety 

Authorized Personnel 
All operations described in this manual should be performed by authorized and trained 
personnel only. For safety and warranty reasons, any internal work on the devices must be 
performed by manufacturer authorized personnel only. 

Appropriate Use 
The 3DLevelScanner™ is a device designed for continuous level or volume measurement. 

Warning about Misuse 
Inappropriate or incorrect use of the device can give rise to application-specific hazards, 
e.g. vessels overfill or damage to system components through incorrect mounting or 
adjustment. 

General Safety Instructions 
The 3DLevelScanner™ is a high technology device which requires strict observance of 
standard regulations and guidelines. The user must take note of the safety instructions 
detailed in this manual, as well as country-specific installation standards, and all common 
safety regulations and accident prevention rules. 
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2 3DLevelManager™ Overview 
2.1 Overview 
The 3DLevelManager™ software is a configuration and monitoring tool for managing 
3DLevelScanner™ devices. 
The software supports various methods for connecting to the scanners, monitoring their 
measurement readings, configuring their various parameters, log results and generating 
various types of graphical reports. 
This manual is compatible with SW version 3.5.0 and FW version 4.0.137 and above. 

2.2 Features 
Major features of the 3DLevelManager software: 

 Supports HART, RS-485/Multi-drop, GSM, GPRS and TCP/IP communication 
interfaces to the linked scanners 

 Supports all 3DLevelScanner models (S, M, MV, ML and MVL) in a single or multiple 
scanner arrangements 

 Easy to use wizard-based parameter configuration tools including graphical 
presentation and configuration aids 

 Various logging options and displaying log information as time-lined graphs 
 3-Dimensional, animated graphical presentation of filling/emptying processes in MV 

and MVL models 
 Built-in advanced analysis tools 
 Fully adaptable to user preferences (measurement units, display modes) 

2.3 System requirements 
The following minimum computer system characteristics are required for 3DLevelManager 
to install and run properly: 

0BComputer Hardware: 
 Processor: Pentium 1GHz 
 RAM: Minimum 1GB 
 Graphic resolution: Minimum 800x600 
 Hard drive: Minimum 18GB free 

memory on HD per year (Verbose log 
enabled), Log file: 50MB/day 

 CD-ROM drive 
 One serial port (built in RS-232 / USB) 

1BOperating System:  
 Windows XP SP2 and Windows 7 
 Microsoft .NET Framework 3.5 SP1 
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3 Installation 
3.1 Installing the software 
1 Insert the APM software CD into the CD drive. 
2 Auto run should start automatically (if enabled in your computer). Otherwise, browse 

the CD and execute the file APM Level Scanner.msi file. The setup wizard appears as 
shown: 

 
 

 

NOTE: If a previous version of the software is already installed on your computer, 
you will be offered with Repair and Remove options, for installing an updated 
version or completely uninstalling the existing software. 
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3 Click Next to proceed with the installation. The following screen appears: 

 
 

4 Click Browse to select a different installation folder if needed. 
5 You may allow other users of this computer accessing the software by selecting 

Everyone, or limit the access for yourself only by selecting Just me. 
6 Click Next to proceed.  
7 In the Confirm Installation window appearing next, click Next to begin the installation 

and wait until the installation progress is complete: 
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8 The software installation is in process, and all the necessary files are being installed in 
your computer. When complete, the following confirmation screen appears: 

 
 

9 APM 3DLevelManager software installation is complete. Press Close to exit the 
installation wizard. 

 
Note the APM 3DLevelManager shortcut icon which has been added to your desktop.  
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3.2 Understanding 3DLevelManager Basics 
The 3DLevelManager software is designed for both end users and technical personnel. 
This chapter includes an overview of the user interface and general details regarding the 
different modes of operation. 

Connection Status 
Once a connection is established, the software downloads all parameters from the 
scanner. The download process may take few seconds depending on the communication 
type and quality, during which the software will not respond and cannot be accessed. 
Once a 3DLevelScanner is connected to the computer running the 3DLevelManager 
software, the connection quality level is indicated by a 5-bar green indicator in the 
Connection field (appears 1 minute after connection) on the upper left side of the window 
(see figure below). The 5-bar indicates the real-time communication quality. If the 
indication level drops (from 5 to 4, 3, 2 or 1 bars) for a significant period, we strongly 
recommend to check the communication physical connection and any other element 
related, such as drivers, network collisions, etc. 5 green bars indicates very good 
communication quality, 3 yellow bars indicate a fair connection and 1 red bar indicates a 
bad connection quality. 

 
The 3DLevelManager in Senior Technician Mode 
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Device Info 
The following device information is displayed on top of the screen: 

 Connection status 
 Hardware interface and port number used for communication with the device 
 Device polling address 
 Tag Name (as defined for this connection) 
 Electronic card serial number 
 Firmware version of the electronic card 
 Hardware version of the electronic card 
 Device type (S / M / MV / ML / MVL) 

 
The Device Information area 

Measured Parameters 
The following device measured parameters are displayed on the 
right area of the screen, as shown to the right: 

 First and second fields represent the calculated output 
selected in the Output Settings under the Device menu. The 
first field shows one of: Volume, Mass, Level or Distance 
with its selected units. The second field shows the 
percentage based on the selected output. 

 Distance (tab): Average distance between the top of the 
scanner body and the material. 

 Min Distance: Minimum distance between the top of the 
scanner body and the material. 

 Max Distance: Maximum distance between the top of the 
scanner body and the material. 

 Level (tab): Average level between all echoes, measured 
from vessel bottom. 

 Min Level: The distance between the lowest measured 
echo to the vessel bottom. 

 Max Level: The level from vessel bottom to the material's 
highest point (equals Empty Calibration–Min Distance). 

 Output Current: 4-20mA analog output current. 
 Temperature: Temperature level around the antennas inside the vessel. 
 SNR: Signal-to-Noise Ratio measured inside the vessel, in decibels (dB). The SNR 

indicates the energy of the transmitted signal compared to the acoustic noise inside 
the vessel. 

Note: Both temperature and SNR are displayed under technician modes. 
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Standard Mode 
Standard Mode is the default operating mode of the software. This mode allows 
connecting and disconnecting the scanner, viewing of log graphs and 3D image and 
performing basic grades analysis. Scanner configuration and Advanced Parameters are 
disabled for this mode.  

Technician Mode 
Technician Mode allows configuration of advanced parameters which are not available 
under Viewer mode (the default operating mode). Switching to Technician mode requires a 
password. 
To switch to Technician mode, choose Tools → Operating Mode → Technician Mode. You 
will be prompted with the Password Request box. Enter the Technician mode password 
and press the OK button. The Technician mode password is techAPM, and it cannot be 
changed. 
For Switching back to Standard mode, select Tools → Operating Mode → Standard Mode 
from the Tools menu (no password required). 
In Technician mode, there are 6 more tabs at the left area of the screen. These tabs allow 
viewing of parameters, modifying part of them. The tabs include other useful tools such as 
False Echo Mapping. This document describes the work under technician mode. 

Senior Technician Mode 
Senior Technician mode allows configuration of more advanced parameters which are not 
available under technician mode. Switching to Senior Technician mode requires a 
password. 
To switch to Senior Technician mode, choose Tools → Operating Mode → Senior 
Technician Mode. You will be prompted with the Password Request box. Enter Senior 
Technician mode password and press the OK button. The Senior Technician mode 
password is admin, and it cannot be changed. 
Further differences between Senior Technician and Technician modes are detailed in this 
manual where relevant. 
No password is needed for switching back to a lower access mode: Select Tools → 
Operating Mode → select the required mode from Tools menu (no password required). 

Debug Mode 
Debug mode can be accessed from Tools  Operating mode menu or by pressing F12. 
This mode is strictly limited for APM development team use and password protected. 
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The 3DLevelManager in Standard Mode 

 

 
The 3DLevelManager in Technician Modes 



 Connecting to 3DLevelScannerTM ● 3DLevelScanner Connection Options  

 3DLevelManager Operating Instructions © 2013 APM all rights reserved 11 

4 Connecting to 3DLevelScannerTM 
4.1 3DLevelScanner Connection Options 
The 3DLevelManager Software enables communication with 3DLevelScanner devices 
using different methods: RS-485, HART, GSM Modem, GPRS Modem and TCP/IP. 
Communicating using an RS-485 is much faster than GSM, GPRS or via a HART 
connection, therefore it is recommended to use standard RS-485 as communications 
infrastructure. 

Establishing a Connection 
Press Communication → Connect... (or click the large red Connect button, or press 
Ctrl+M) to initiate a connection between the 3DLevelManager and the connected 
scanners. This opens the connection box which allows choosing the required 
communication properties and establishing data connection between the software and the 
scanner. The Connect window allows different communication setup for different 
operators. 
In the Connection Method field, select the communications interface used for connecting 
the scanner to the computer and the software. For detailed information regarding the 
communication options and settings, refer to page 22: Connect… 

 
Connection window in Technician Mode 

 
RS-485 Connection  
The figure on the next page shows a schematic connection between a PC running the 
3DLevelManager software and a 3DLevelScanner, using an RS-485 connection. For more 
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information about physical connections, refer to the APM 3DLevelScanner Operating 
Instructions manual. 

 
RS-485 Connection 

HART Connection 
When using an RS-232/USB HART Modem, a 250 Ohm resistor is required.The figure 
below shows a local connection between a PC running the 3DLevelManager software and 
a 3DLevelScanner, using a HART modem connection. 
 

 
HART Modem Connection 
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In this figure: 
1 RS-232/USB Connection 
2 3DLevelScanner 
3 HART Modem 
4 HART Resistor - 250 ohm, can be placed on any of the 4-20mA lines 

GSM 
The GSM option enables a modem-to-modem communication. This type of connection 
requires a GSM modem connected to the scanner on one side, and a GSM modem 
connected to the computer on the other side. The telephone number of the modem 
connected to the scanner is required. 

GPRS 
The GPRS option allows IP connection to a remote 3DLinkPro with GPRS enabled. When 
selecting this option, a TCP port must be opened in the local network and to be forwarded 
to the computer running the 3DLevelManager. On pressing Connect, an SMS message 
should be sent manually to the 3DLinkPro in the following format: 
CALLAPM,[external IP address],[TCP Port],[APN],  
A comma must end the SMS message. 
For example: 
CALLAPM,82.123.25.102,7024,internet, 

TCP/IP 
The TCP/IP option allows converting and transferring the RS-485 data over TCP/IP using 
compatible converter. When establishing a connection to the TCP/IP converter, the local 
IP address and the TCP port values must be set as defined in the converter. 

GPRS + SMS 
This option creates a GPRS connection without manual sending of an SMS message. A 
3DLinkPro unit must be connected to the local computer running the 3DLevelManager 
software in order to send the SMS message to the 3DLinkPro connected to the scanner. 

GPRS + SMS Server 
This option creates a GPRS connection without manual sending of an SMS. A 3DLinkPro 
unit must be connected to a computer in the network in order to send the SMS message to 
the 3DLinkPro connected to the scanner. This option is available for Senior Technician 
and to be used when several computers in the same network can be connected to different 
scanners and 3DLinkPros. 

Multiple Scanner Connection 
When connecting several scanners in a Daisy-Chain, the 3DLevelManager can be 
connected to all scanners and a specific scanner may be chosen to be viewed at any time. 
For this type of connection, each scanner must be set with a different polling address. One 
of the scanners must be set with a polling address of 00. 
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Using the Phonebook 
The 3DLevelManager stores a file named PhoneBook.ini which contains all connections 
and their properties. Each connection can be named and stored automatically in the 
phonebook file for further use. Based on the phonebook entries, a folder is created to store 
relevant data such as grades analysis. 
For viewing and editing the phonebook, select Browse to local folder from the File menu, 
and select the file 'PhoneBook.ini'. Each connection entry should start in a new line and 
with a different name. 
Examples for Phonebook entries may look like: 

[APM Scanner] 
Polling=Multiple 
Method=GPRS2 
COM= 7 
LocalIP=192.168.2.130 
APN=internet 
Number=+972541234567 
LocalPort=7040 
 
[Test 1] 
Polling=Multiple 
Method=485 
COM=6 
 
[TCPIP Connection] 
Polling=00 
Method=TCP 
HostIP=192.168.2.48 
HostPort=7040 
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5 First-time Configuration 
This chapter describes the recommended steps to be taken for configuration of the 
scanner and bringing the scanner to full capability mode, in their recommended order. 

5.1 Configuration Wizard 
Use the 5-stage configuration wizard for first-time configuration of the 3DLevelScanner. 

 

NOTE: Prior to 3DLevelScanner configuration, verify that the 3DLevelScanner 
has the most up-to-date firmware version installed. 
NOTE: Make sure the operating mode is set to Technician mode before trying to 
open the Configuration Wizard. Technician mode password is ‘techAPM’. 
NOTE: When working with scanners of firmware version later than 3.1.0, the 
wizard pops up automatically when the scanner is set to factory defaults. 

From the main menu, select Device → Configuration Wizard... (or press F4) to activate 
the wizard. 
The configuration wizard appears, starting at its first stage. 
During wizard navigation, the following options are available at 
any stage: 

 Click Previous to switch to previous stage. 
 Click Cancel to exit the wizard without completion. No 

parameter will be modified or saved to the scanner. 
 Click Next to continue to the next stage. 
 Upload All available only for Senior Technician 

Step 1/5: Set System Parameters 
Step 1 allows choosing device name and preferred measurement units. 

Set the device tag name/identity in the Tag Name field. This name is displayed on 
the scanner screen and in the software window title once the device is connected. 
The tag name field is limited to 16 characters. 
Choose the preferred distance measurement units in the Distance Unit field. The 
available options are: meters (m), centimeters (cm), millimeters (mm), feet (ft) and 
inches. 
Choose the preferred temperature measurement units in the Temperature Unit field. 
The available options are: Celsius and Fahrenheit. 
Click Next. 

1 

2 

3 

4 
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Set System Parameters stage 

Step 2/5: Set Vessel Parameters 
Step 2 allows identifying the vessel geometry including with a specific shape for exact 
volume analysis. 
The vessel major parts (top, center and bottom) schematic geometry can be chosen and 
dimensions can be defined. 

Choose the proper shape for the vessel top from the Top Shape field. The options 
are: Flat, Cylinder, Dome, or Pyramid. Set the dimensions: 
 For a Cone shape, set the height and the top diameter of the cone. 
 For a Dome shape, set the height of the dome. 
 For a Pyramid shape, set the top section height, width and length of the vessel 

top at the X and Y directions. 
Choose the proper shape for the vessel center from the Center Shape field. The 
options are: Cylinder or Cube. Set the dimensions: 
 For a cylinder shape, set the height and the diameter. 
 For a cubic shape, set the height, width and length of the vessel according to the 

X and Y axis, respectively. 
Choose the proper shape for the vessel bottom section from the Bottom Shape field. 
The options are: Flat, Cone, Dome, or Pyramid. Set the dimensions: 
 For a Cone shape, set the height and the bottom diameter of the vessel bottom 

section. 
 For a Dome shape, set the dome height. 

1 

2 

3 
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 For a pyramid shape, set the height, width and length of the vessel bottom 
section at the X and Y directions. 

 If the vessel shape is asymmetrical (for both cone and pyramid shapes), it is 
possible to set the bottom center as an offset from the entire shape center. The X 
Position and Y Position are the offset of the bottom section from the center. 

Click Next. 

 

Set Vessel Parameters stage 

Step 3/5: Set the Device Position 
This stage allows specifying the exact location of the scanner on the vessel’s top. 

Set the device location according to the previously defined top vessel shape using 
one of the following methods. 
 Drag the device on screen, or 
 Enter the X and Y coordinates in Device Position fields at the top right corner. 
 Set the Offset from Vessel Top if the scanner is not installed on the vessel ceiling 

but a standpipe or socket is used, or the scanner is lowered using neck extension 
or head-body separation kit. 

 The offset referred to the top part of the antenna body and not necessarily to the 
flange. 

 

NOTE: The device Z position is being calculated automatically. 
NOTE: The Side View image will display the changes of the scanner (if the 
offset parameter is used) and will show the scanner when mounted on the 
ceiling slope or a horizontal rooftop. 

4 

1 
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NOTE: In Senior Technician Mode it is possible to set the angle manually or 
by double clicking the angle field. 

Click Next 

 

Set the Device Position stage 

Step 4/5: Set Filling Points 
This stage allows configuration of the vessel filling points. Up to 9 filling points may be 
defined. The following figure describes a schematic top view of the vessel and the filling 
point locations. 

Set the filling points using one of the following methods: 
 Bring the cursor to the desired location over the vessel top shape and left-click 

the mouse to add a filling point, or: 
 Press Add and enter the X and Y coordinates in the Filling Points table and 

press Enter button after every number entered. 
To edit a field: double click the field, enter the required value and press enter. 
To delete a filling point, mark the corresponding row and click Delete. 
To delete the full list of filling points, click Clear All. 
Click Next. 

2 

1 

2 
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Set the Filling Points 

Step 5/5: Set Full and Empty Calibration Levels 
This stage allows configuration of the vessel full and empty calibration levels. The 
following figure show the full and empty calibration fields to set. 

Set the distance from the flange (or top of the horns body) to the material 100% 
(20mA) level (see figure below) using the Full Calibration field. Default value is 0.5m 
(1.64ft). Dead band is 50cm (1.64ft). 
Set the distance from the flange to the material 0% (4mA) level (see following figure), 
using the Empty Calibration field. 
Distance from flange to bottom – represent the maximal distance between the 
flange (or top of the horns body) to the bottom of the vessel, double clicking this field 
will set the empty calibration level with the same value. 
Press OK. 

1 

2 

3 

4 
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Set Full and Empty Calibration Levels 

If parameters were modified during the wizard process, the following box appears 
(figure to the right) offering an option to upload all parameters to the scanner. 

 Click Yes to upload parameters to the scanner and to close the wizard. 
 Click No to close the wizard without uploading parameters to the scanner. 
 Click Cancel to close the window and stay in the wizard. 

 
Upload configuration to the scanner 

5.2 Advanced Configuration Parameters 
Following the completion of the configuration wizard, open the advanced parameter 
window (press DeviceAdvanced Parameters… or press F5) in order to set general 
parameters such as Material Slope and Damping Time. Other parameters may be 
configured and fine adjustments can be done at a later stage. Refer to page 28: Advanced 
Parameters… for detailed instructions and descriptions. 
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5.3 Grades Analysis 
Once configuration is complete, a Grades Analysis should be performed for viewing the 
returned echoes from the material surface and using the analysis results to adjust the 
scanner. Refer to page 45: Analyze… menu for detailed instructions. 

5.4 False Echo Mapping 
In vessel installations with high sockets, struts or agitators, corrugations, as well as with 
material buildup and welded joints on the vessel walls, reflection interference occur which 
may result in erroneous measurements. The False echo mapping allows marking these 
false echoes to be ignored during volume measurement. It is advised to map out the false 
echoes when the vessel is close to empty for detection of all potential interfering 
reflections. 
The false echo mapping feature is located under the Tools menu, and allows automatic 
scanning (enter a range to scan), manual scan (enter the range and threshold) and to 
reset all false echo mapping (including Auto False Echoes). Refer to page 46: False Echo 
Mapping. 

5.5 Log Viewer 
The 3DLevelManager collects all data received from the scanner and stores it on the local 
computer's hard drive. Selecting ViewLog File... or by pressing CTRL+W opens the 
logs viewer application. When a scanner is connected, the log graph starts from the 
connection time and date. Browsing for old logs can be done by pressing the browse 
button [...] and selecting the folder/s for viewing the log file/s contents. 
The logs are saved in HTML format and are stored in a folder named with the connection 
time and date. For more information, refer to page 43: Measurement Logs. 

5.6 3D Image Profile 
The 3DLevelManager is equipped with a highly useful feature of generating and displaying 
a 3-dimensional, graphical representation of the visual mapping contour of the stored 
material as scanned by the 3DLevelScanner MV and MVL models. For more information, 
refer to page 39: 3D Image. 
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6 Software Menus 
This chapter describes the different functions available under the software menus and sub-
menu options, ordered as they appear in the menu. 

6.1 File menu 

Load parameters for Browsing… (Ctrl+B) 
Opens a saved parameters file (.APM file) for browsing only. Uploading to the scanner is 
not possible. 

Load Parameters to Device… (Ctrl+D) 
Opens saved parameters file for directly upload to a connected scanner. 

Save Configuration… (Ctrl+S) 
Saves all parameters (Basic settings, Output settings and, Advanced Settings) to an .APM 
type file. You can choose the location and the file name to be saved. 

Browse to Local Folder… 
Open the local 3DLevelManager Application Data folder.  This folder includes different log 
files and grade analysis files. 

Generate a New Log File 
Stops storing data on current log file and generates new file with an updated time and date 
stamp. A new log folder will be created under the data folder, for storing log files with all 
data from the scanner. At least 2MB/day free hard drive space should be reserved for the 
logging activity in normal connection (not Verbose). 

Exit (Ctrl+X) 
Exits the 3DLevelManager software. 

6.2 Communications Menu 
This menu allows connecting and disconnecting to / from the device as well as polling 
address selection, communications quality test and log file / history viewing. 

Connect… (Ctrl+M) 
Opens the connection box which allows setting of the required link and communication 
properties and to establish a data connection between the software and the scanner(s). 
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In Standard mode, RS-485, TCP/IP or HART options are available. When switching to a 
higher operation mode, more options become available. This chapter describes all options. 
Under the Site, type in the Site Name in order for it to be saved in the 3DLevelManager 
Phonebook.ini file for future use and tracking. The stored logs and grades analysis are 
stored under a folder created using the site name entry. 
In the Connection Method field, select the communications interface used for connecting 
the scanner to the computer and the software. The available options are: 

 RS485: Connection over RS-485 bus. 
 Select the serial COM Port number the RS-485 Converter is connected to 
 Select the scanner polling address or Multiple to connect to all scanners. 
 Click Connect. 

 
 TCP/IP: The scanner is connected via a TCP/IP network to an RS-485 connection. 

 Select the site name. 
 Select the scanner polling address. 
 Set the Server IP address and IP port number in the Further Configuration 

section.  
o Server IP is the device converting RS-485 to TCP/IP.  
o IP Port is the TCP Port assigned to in the TCP/IP converter. 
o Chain Number – When connecting to 3DMultiVision Server it is possible to 

connect to a specific chain and specific polling address to monitor, this is 
designed when there are several connection types in the 3DMultiVision 
Server with possible several scanners having the same polling address. 

 Click Connect. 
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 HART: The scanner is connected using a HART modem. 

 Select the serial COM port number the HART modem is connected to, and enter 
the scanner polling address. 

 Click Connect. 
 GSM (Modem): The scanner is connected using a local GSM modem. 

 Select the serial local COM port number and enter the scanner polling address. 
 Select the site name and enter the phone number of the other side modem. 
 Click Connect. 

 
 GPRS: The scanner is connected through the internet over GPRS using 3DLinkPro. 

 Enter the local IP port number and the scanner polling address. 
 Click Connect. 
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 Send an SMS message from a mobile phone to the scanner to initiate the 
connection. 

 GPRS + SMS: The scanner is connected via the internet using 3DLinkPro. This 
connection uses SMS messages sent from a GSM modem connected to the 
computer. 

 Select the site name. 
 Select the serial COM port of the 3DLinkPro connected to the computer. 
 Select the scanner polling address. 
 At the right pane, set phone number of the 3DLinkPro connected to the scanner. 
 Set the computer local IP port. 
 Set the external IP address (usually the router IP address). 
 Set the APN word of the 3DLinkPro connected to the scanner. 
 Click Connect. 

 
 GPRS + SMS Server (Available only under Senior Technician mode. To be used by 

APM authorized distributors): The scanner is connected via the internet using 
3DLinkPro. The link uses SMS messages using a GSM modem connected to a 
computer on the local network. 

 Select the site name. 
 Select the scanner polling address. 
 At the right pane, set phone number of the 3DLinkPro connected to the scanner. 
 Set the computer local IP port. 
 Set the external IP address (usually the router IP address). External IP address 

can be obtained using web services such as www.whatismyip.com. 
 Set the APN word of the 3DLinkPro connected to the scanner. 
 Set the TCP Port of the computer connected to the modem sending the SMS 

message. Default port number is 9669 and it should not be changed 
 Set the IP address of the computer connected to the modem 

http://www.whatismyip.com/
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 Click Connect. 

 
 Polling Address: Enter the scanner polling address when connected via daisy-chain 

connection (RS-485 Multi-drop). Address range: [00 to 63 or Multiple]. When selecting 
Multiple, each scanner must have its own, unique address. 

Disconnect 
Disconnect software communication to the device. 

Polling Address Selection… 
Available when the manager is connected in Multidrop. Use the dialog box to select polling 
addresses of multiple 3DLevelScanner scanners to be monitored using a Multidrop 
connection. 
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Check the check-boxes with the polling address per each scanner to be monitored. Log 
files will accumulate data for all checked scanners. 

 Normal Scanning scans all the selected scanners. This is the default value and 
should not be changed. 

 Slow Scanning adds a delay between polling of each scanner. Useful when 
communication speed is low 

 Pause Scanning stops communicating with other scanners except current scanner to 
retrieve information, until setting back to normal or slow scanning mode. 

 

NOTE: The scanning option parameter selection should not be modified. 
NOTE: This option works only if there is a scanner with polling address 00. This 
scanner saves the polling address selection table. 

Communication Quality Test 
This tool tests the connection quality between the 
computer and the scanner. If packets not answered, or 
received with errors, the cable must be checked for 
existence of proper resistors on both sides and verified to 
be of shielded and twisted-pair type.  
An example for a good test result: an averaged delay of 
97msec (very low), no lost packets and no errors 
received.  

 Click Restart Test to restart testing. The test will 
cycle through until terminated. 

 Click Close to terminate and close the window. 
It is important to test the quality of the communication 
between the computer running the Manager and the scanners after initial setup and 
connection. 

Communication Log File… 
The Communications Log File contains logged data corresponding to the communications 
between the software and the scanner connected to it. Selecting this option opens the file 
in an Internet browser window. The file format is HTML and it might be required for 
technical support use. 

Communication History… 
The Communications History contains logged data corresponding to the communication 
events between the software and the scanner connected to it. Selecting this option opens 
the file in an Internet browser window. The file format is HTML and it might be required for 
tech support use. 

Generate 3DV Files 
By pressing this option, the manager will generate a .3DV file. This file is generated to be 
used with the SCADA integration files, please contact APM Customer Support for 
additional information. 
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6.3 Device Menu 
This menu allows accessing to advanced configuration options. Some of the menu options 
are disabled on Viewer mode, and become available under Technician mode. 

Configuration Wizard… (F4) 
The configuration wizard provides a wizard-based, graphical-aided tool for configuring a 
connected 3DLevelScanner. At the first run after software installation or following a new 
scanner connection, all wizard steps must be followed and all parameters should be 
configured according to the Installation Preparation Form (IPF) filled prior to the installation 
and approved by the APM Customer Support or by your local distributor. 
Refer to page 15: Configuration Wizard for a detailed description regarding the 
configuration wizard. 

Advanced Parameters… (F5) 
Opens the 'Advanced Parameters' box, where the algorithm parameters can be adjusted. 
This window is available under Technician and Senior Technician modes only. 
The various fields can be downloaded or uploaded from/to the scanner. Any changed 
parameter, if not uploaded to the scanner, can be discarded using the Cancel button at 
the bottom. We recommend consulting an APM official distributor or APM Technical 
Support before changing any of the parameters. 
When connecting to a 3DLevelScanner with earlier firmware version (2.x.x), the Advanced 
Parameters window will looks different and may include other visible parameters. 
In Technician Mode, the user has limited access to the parameters. 

 Output Damping Time: Sets the history dump window time of the scanner. This 
parameter increases stability and improves the SNR. Default value: 300 seconds, 
minimum value: 60 seconds. 

 Steepest Material Slope: Set the maximum material slope. The scanner verifies all 
echoes for not exceeding the slope. Default: 35°. Recommended setting: between 30° 
to 45°. 

 Max Capacity [tons]: The total capacity of material within the vessel. 
 Max Emptying Rate [tons/hour]: The maximum emptying rate. 
 Max Filling Rate [tons/hour]: The maximum filling rate. 

It is recommended to set the maximum capacity and Filling/Emptying rates according to 
the actual process in the vessel. 

 Top Dead Band [Discard/Don’t Discard]: To be used only when echo cancelation 
using mapping range for short distances is not possible. The unit discards all echoes 
up to the full calibration. Default: Don’t Discard. Discard: The sensor scans material 
only at a distance larger than full calibration distance. Don’t Discard: Distances 
smaller than full calibration distance are scanned as well. If measured distance to the 
content is smaller than full calibration, the full calibration distance is presented. 

 Historic Log Sampling Period: Sets the interval between measurements that are 
saved into the local memory. By default, the scanner does not store the log. The 
settings are ranged between 1 to 60 minutes. If the scanner has been reset due to 
powering off or via the software, this parameter resets to its default value and the log 
will not proceed with data accumulation. 
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 Auto False Echo: Enable/Disable, Sets the algorithm to automatically calculate false 
echo levels, enabled by default. Setting this parameter to Disable stops the scanner 
from continuously calculating the false echo levels and keeps the last image of false 
echoes. If the false echoes are manually reset, the level is set to 0. 

 User False Echo: Enable/Disable, Sets the algorithm to consider the false echo 
mapping created manually by the user (enabled by default). Setting this parameter to 
Disable causes the scanner to ignore the manual false echoes. 

 
Advanced Parameters in Technician Mode 

 Mechanics Type [I/II]: Sets the type of configured scanner. The options are I or II. It is 
extremely important to set the mechanics type to avoid wrong calculations. 

 CFAR Sensitivity: Constant False Alarm Rate detection – an automatic threshold 
algorithm. Setting the sensitivity adds gain to the CFAR threshold (default: 9dB). 
Adding 6dB doubles the gain [dB]. This is an adaptive and robust algorithm for 
detection of targets in a noisy environment. 

 Minimal SNR [dB]: The lowest SNR threshold. Below this level, the sensor does not 
measure and the reading remains unchanged. Default: 13dB. Setting the minimal 
SNR to a value lower than 10dB is not recommended. 

 Restrain coefficient [%]: Sets the level of preference of echoes from shorter 
distances over echoes from farther distances. 100% = no preference of closer echoes. 
0% = total preference of the first echo. Default: 10%. 

 Side Margins [m/ft]: Allows tolerance in echo recognition to vessel walls (see figure).  
Used for creating a tolerance in case of unknown vessel width/diameter, and when a 
tolerance is required for detecting points on the vessel walls.  
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Echo within the tolerance/margin range is transformed to the vessel wall on the X-Y 
plane and will not be eliminated in calculation. Default: 1m (3.28 ft.). 

 Bottom Margins [m/ft]: Allows adding a tolerance in echo recognition from the bottom 
shape (but not flat) (see figure).  
This feature is used for creating a tolerance in the case of unknown vessel 
dimensions, and when a tolerance is required for detecting points from the bottom of 
the vessel. Default: 1m (3.28 ft.). 

 
Side and Bottom margins 

 User False Echo Sensitivity: Refers to the Manual False Echo mapping created by 
the user. The minimum extra gain required to distinguish between real echoes and 
mapped false echoes. Decrease sensitivity if false echoes prevent the device from 
tracking the true level. Increase the sensitivity if false echoes are not ignored. Default 
value: 1.2. 

 Auto False Echo Sensitivity: Refers to the auto false echo calculation done by the 
algorithm. The minimum extra gain required to distinguish between real echoes and 
mapped false echoes. Decrease sensitivity if false echoes prevent the device from 
tracking the true level. Increase the sensitivity if false echoes are not ignored. Default 
value: 1.2. 

 Exceeding Filling Rate After Echo Loss: Enables quick recovery after echo loss, for 
example, when the SNR is below Minimal SNR, the algorithm assumes that there is a 
filling process and upon SNR recovery, the algorithm will exceed the filling process to 
the level of material. By default, this feature is set to Yes. 

 Angle Adaptor: In case the horns are installed in an angle with an APM Angle 
Adaptor or with other mechanical solution it is required to adjust the angle in the 
configuration. By default, the angle is set to 0°, maximal value is 30°.  

 

NOTE: Make sure the horn’s direction is in the same direction as the angle 
adaptor and is directed towards the center  of the vessel. 
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Advanced Parameters for Senior Technician 

 Beams Activation tab allows choosing manual or automatic (by the algorithm) beams 
selection. By default, the beams are selected automatically. Part of the beams will be 
removed depending on silo dimensions. 
High, Med and Low Frequency beams represent three separate transmissions which 
emit signals from all three antennas simultaneously. 
30, 90, 150, 210, 270 and 330 degrees directions represent 6 separate directional 
transmissions which improve the algorithm's analysis of the returned echoes. All 6 
transmissions are transmitted in the same frequency as the Med frequency (4.5KHz). 
Beams can be enabled or disabled by removing the check box from the Activate All 
Beams box. A selection of less than three directional beams is not allowed. Only a 
selection of at least three consecutive beams is possible, for example: Direction 30, 
Direction 330 and Direction 270. 

 Automatic Beams Range: enabled by default. The beams range is limited according 
to the range at which the beam hit the vessel wall. Low frequency beam has wider 
angle and thus is more limited. High frequency beam is very narrow and has no 
limitations. At every possible beam selection the algorithm makes sure that at least 
one beam has enough range to 'see' the bottom of the vessel. This limitation is 
visualized in the Grades analysis window as the orange vertical line. 
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Beams Activation under Senior Technician Mode 

 
Example of range limitation represented as the vertical Orange line 

 Download All: Downloads all parameters from the scanner to the software. 

 

NOTE: Three options are available for downloading all parameters from the 
device: using the Main Screen, using the Device menu and using this 
Advanced Parameters window. 

 Upload All: Uploads all parameters from the software to the scanner. 

 

NOTE: Four options are available for uploading all parameters to the device: 
using the Main Screen, using the Device menu, using this Advanced 
Parameters window and using the last step of the wizard. 
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 Cancel: Closes the Advanced Parameters windows without up/downloading from/to 
the scanner. If the Upload All button is not pressed, the changes will not be saved. 

Current Output Settings... (F6) 
The Current settings window is designed to control the 4-20mA output signal. The window 
includes two major functions: 

 Current Simulation: The output current can be simulated by setting Volume (%), or 
Current (mA). This feature is useful for synchronizing with the PLC and verifying of 
identical read values for both the scanner and the PLC. When the simulation is active, 
a red blinking signal appears, indicating: Simulation is Active. 

 Current Output Mode: Allows setting the output to send the standard 4-20mA signal, 
or optionally to send a reverse signal: 20-4mA. The last option sets the scanner to 
output a fixed value. 

 Output Type: Switches between Average, Min Level and Max Level options to output 
in the 4-20mA interface. 

 

NOTE: Notice the simulation indicator, shown when the simulation is active. 

 

Output Settings… (F7) 
The Output Settings defines the displayed calculation and how the 4-20mA output 
behaves. The output type of Volume (default), Mass, Level or Distance can be selected. 

 Volume:  
 Calculation Using Silo Structure –calculates the volume based on the silo 

structure defined using the configuration wizard. The displayed units can be 
selected to be available to the user. 
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 Calculation Using Level-Volume Table – allows setting a linearization table 

based on level to volume conversion 
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Level-Volume Linearization Table 

 Calculation Using Distance-Volume Table – allows setting a linearization table 
based on distance to volume conversion (to be done the same as above). 

 Mass: 
 Calculation Using Fixed Bulk density – Calculation of mass based on the silo 

structure and volume calculation at a certain level. The bulk density value can be 
entered as Tons/M3 or lbs./ft3 units. 
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 Calculation Using Level-Mass Table – conversion of the calculated average 
level directly into mass 

 
 

 
Level-Mass Linearization table 

 Calculation Using Distance-Mass Table – conversion of the calculated average 
distance directly into mass (to be done same as above) 
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 Calculation Using Level-Variable Bulk Density Table – conversion of the 
calculated average level into volume, based on silo structure and multiplying by 
the bulk density value at that level to convert into mass 

 
 

 
Level-Mass table using Variable Bulk Density 
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 Calculation Using Distance-Variable Bulk Density Table – conversion of the 
calculated average distance into volume, based on silo structure and multiplying 
by the bulk density value at that distance to convert into mass (same as above) 

 Level – Output the Level of material 

 
 Distance – Output distance to material 

 
 Output Settings windows buttons functionality: 

 Upload – sends all information to the scanner. If not all parameters are properly 
configured, an alert pops up with the problem indicated. 

 Open Table – when available, the table can be edited according to the 
requirements 

 Cancel – discards all changes and close the window 
 OK – keeps settings and advise upload the changes to the scanner 

 Table buttons and functionality: 
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 OK – saves the configuration. Uploading from the output settings window will be 
required 

 Cancel – discards all changes and closes the table window 
 Apply – upload all updated settings to the scanner 
 Show Vessel – enlarges the table window and shows the silo structure and level 

indication when selecting a table row 
 Operations on the table: 

o Right clicking the row number allows: Add Row Above, Delete Row, Clear 
Rows Above, Clear Row, Clear Rows Below 

o Right clicking the # on the top left of the table allows clearing the entire table 
o Right clicking the editable column allows clearing the column  

Upload All (F2) 
Upload all parameters from the software to the scanner. 

Download All (F3) 
Downloads all parameters from the scanner to the software. 

Device reset 
Allows the following resets options:  

 Restart Scanner: Sends a restart command to the scanner. The internal DSP boots 
and starts building the auto false echoes and damping values. The initialization 
process takes about 30 seconds. The scanner will perform a new search for the 
correct measurement. 

 Reset to Factory Defaults: Resets most of the system parameters to their factory 
default settings. All parameters must be re-defined following this operation. The 
following parameters remain unchanged: 'Output Damping Time' and 'Steepest 
Material Slope'. 

 Reset Advanced Parameters: (available only with firmware versions 3.x.x) Resets all 
advanced parameters. This function will not reset the 'Output Damping Time', 
'Steepest Material Slope', ‘Max. Capacity’, ‘Max. Emptying Rate’ and ‘Max. Filling 
Rate’. Scanner’s configurations set in the Configuration Wizard will not restore to 
factory defaults. 

6.4 View Menu 

3D Image… 
Generates and displays a 3-dimensional graphical representation of the visual mapping 
contour as scanned by the 3DLevelScanner MV or MVL. 
The legend scale to the right side displays the measured level. 

 To rotate the 3D image, press and hold the mouse left key and drag over the image at 
the desired rotation direction. 
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 The Manager application generates 3D mapping frames depending on the connection 
rate. To watch the animation, click Watch Log. A new 3D image and a browse 
window opens. Select the desired log folder (located under the Logs folder). Use the 
video controls to play, stop, move backward or forward or scroll along the time line. 
The interval in milliseconds (msec) sets the frame time interval. The minimum value is 
1msec. 

 For switching between a zoomed-out view of the silo and a zoomed-in view of the 
material surface, click the top right button or double-clicking the 3D image itself. 

 
Visual mapping window Visual Mapping Options 

Right-click the mouse to open the additional features menu: 
 Show Vessel Geometry Only: Displays the vessel geometry without material. 
 Show Device: Displays the device relative to the vessel geometry. 
 Show Fill Points: Display filling points relative to the vessel geometry. 
 Material Color…: Choose a desired material color from a pop up color chart.  
 Show Axes: Displays the x-y-z axes. 
 Activate Pan Mode: Switches from image rotation to panning. 
 Save Image As…: Performs a screen capture of the entire window for saving as an 

image file. 
 Misc: Opens a sub-menu with the following options: 

 Show Silo Dimensions Wall: Displays a grid with dimensions, similar to the 
zoomed-in image. 

 Show Full and Empty Calibration: Add the full and empty calibration levels as 
configured in the scanner. 

 Draw Silo Grid (Wireframe): Displays a wireframe over the material surface. 
 Show Solid Material Color: Displays the material in a solid gray color. 
 Fill Bounds with Material: Shows the complete material around the surface, or 

the surface only. 
 Hide Top Shape: Hides the top part of the vessel (if not flat). 
 3D Algorithm Accuracy: Controls the number of points in the image. Available 

options are: Normal, Good and Best. Default option: Normal. Changing the option 
is not recommended since a high value consumes most graphic card resources. 
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 Device Components Size: Change the scanner image size, options: Real, 
Relative Large, Relative Normal and Relative Small. 

 
Visual Mapping Misc options 

 View: Opens a sub-menu with selectable viewing angle. 

3D Movie… 
The Visual Mapping feature allows building and viewing a movie based on the generated 
3D representations as frames. When activated, a browser window automatically opens for 
selecting the desired logs folder for generating the movie.  
The 3D movie feature works only with MV or MVL scanner model logs. 
After selecting the log folder, it is possible to play the movie, pause, skip to next scene or 
return to previous one, jump to start or to the end. 
It is also possible to select the polling address of the desired scanner to view and to set an 
interval time in milliseconds, the interval time define the pause between two 3D image 
shots. 
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Grades FW 2.x.x Logs… 
Allow viewing grades analysis results conducted on scanners with FW version 2.x.x. 

 
Example of Grades Analysis log with FW 2.x.x 

Grades FW 3/4.x.x Logs… 
Allow viewing previous grades analysis window conducted on scanners with FW version 
3.x.x or 4.x.x. 

 
Example of Grades Analysis log with FW 3/4.x.x 
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Measurement Logs… (Ctrl+W) 
Loads a log file and displays a chart presentation.  

 The Log option displays charts for Distance (m/ft), Volume (%), SNR (dB) and 
Temperature (°C/°F) over a time line as shown. Log files are saved as the connection 
is established. The files are saved in a local folder. 
For viewing older log files, press the […] browse button. A browsing window opens, 
showing the Logs folder for choosing a different log file. The file names include the 
date and time of the connection. It is possible to select multiple folders or files to be 
merged together into one log. 

 The LogViewer application includes three menus with the following options: 
 FileBrowse to Local Folder – Opens the Windows Explorer application in its 

files location 
 FileExit – Exits the LogViewer application 
 PreferencesDistance Unit – Allows changing the displayed units in the 

Distance chart between: m, cm, mm, ft, inches 
 PreferencesTemperature Unit – Allows changing the temperature units 

between Celsius and Fahrenheit 
 PreferencesTime Offset – allows adding time offset (between +12 to -12 

hours) from the local computer’s clock 
 HelpAbout – Opens the About window 

 

Log File graph representation 
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In Multiple Mode, the software monitors all the scanners selected in the Polling Address 
Selection (see page 26). For viewing a different scanner log file, select the scanner 
Polling Address in the drop-down list at the top-right corner. 
Use the preference menu for displaying logs in different distance units (m, cm, mm, ft., 
inch), different temperature units (Celsius, Fahrenheit), different time zone (hours 
difference) and different regional settings (using dots or commas as digit separators). 

Working with the Graphs 
Zoom-in, zoom-out and pan options are available for all charts created by the 
3DLevelManager: Grades Analysis, Log and Historic log. 

 Zoom-In: Choose a rectangular area you wish to zoom in and place the mouse cursor 
on the top left corner of it. Left click the mouse and drag it to the bottom right corner of 
the required area, making sure not to release the mouse button until the entire 
required area is selected. 

 Zoom-Out: Place the cursor of the mouse inside the graph, left click the mouse and 
move it from bottom right to top left and release the mouse button. 

 Pan: Right click the mouse button and hold it inside the graph area. While moving the 
mouse, the graph will pan to the sides. 

 Back to default view: In the Grades Analysis window, double clicking on the graph 
pops up a box for data reloading confirmation. 

Historic Log… 
The scanner allows storing logs in its local memory. Use the Historic log settings in the 
Advanced Parameters feature to enable this option. To view the log from the scanner 
memory, select the Historic Log… option. 
When selecting the Historic log, a box appears asking for selection of the required log time 
to be retrieved from the scanner. Once download is complete, a log viewer window opens 
displaying the logs. The log data is then saved under the Historic log folder. 

 
Historic Log window 

 

Note: This option allows choosing a 3D Log option which creates a 3-
Dimensional representation of the log. The option is not available under 
Technician Mode. 
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6.5 Tools Menu 

Analyze… (Ctrl+Z) 
The Grades Analysis tool allows a selection of different signal types downloaded from the 
scanner at a preferred time resolution and generates a chart-type report for each scan. On 
choosing this menu option, the following box appears:  

 Select All Grades Info to analyze the scanner behavior in the vessel. 
 The application automatically starts the analysis once the Analyze window is opened. 

The tool will start downloading the signals from the scanner. This stage takes a few 
seconds or minutes to complete, depending on the communication quality and speed. 
Once completed, the analysis results window appears. 

 Click Cancel to stop the download. 
 Click Close to close the Analyze… window. 
 Click View Grades FW 3/4.x.x and select the file from the appropriate folder for 

uploading a certain signal (channels, grades, or false echoes). 
 All Grades Info: Checking this option causes the analyze tool to download the 

Grades, Grades Threshold (controlled by an automatic algorithm), False Echoes and 
Auto False Echoes. The files are saved under a separate folder named with the tag 
name, date, and time. Note that when checking this option, the rest of the options 
cannot be selected. 

 Continuous Grades: This feature allows running the grades analysis continuously for 
later viewing of the changes in material and scanner behavior over time for an in-
depth analysis. The Continuous Grades feature is also possible with all scanners 
connected in multi-drop connection. Use the Every field for setting the pause interval 
between two scans, the minimal value is 3 minutes between scan stop to new scan 
that starts. 

 Channels: Checking this option causes the analyze tool to download the nine signals 
returned to the transducers. Enter the maximum scanning range in the Max Range 
field.  

 Noise: The Analyze tool will start a noise test. 
Channels and Noise tests are to be used only when an APM Technical Support 
personnel requires this operation. This feature is intended for engineering use only. 

 

NOTE: All files are saved under a separate folder, named with the tag name, 
date and time. 
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Grades Analysis dialog 

False Echo Mapping… 
Allows the user to map out false echoes according to the grades analysis (and based on 
them). 

 Scan – Automatic false echo mapping between the set ranges From/To 
 Manual Scan – set a constant level at the defined threshold between the From and 

To distances 
 Reset All False Echoes – delete all false echoes done by the Auto False Echo 

algorithm and in the False Echoes Mapping created by the user. 
 In Senior Technician mode, it is possible to do the false echo mapping operation on all 

beams or just on a specific beam based on the user’s requirements. 
 Start Scanning (or Reset Mapping) – press to start the calculation. 

 
False Echo mapping in Senior Technician mode 
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Suggested steps for Grades Analysis and False Echo Mapping 
It is advised to take a manual measurement of the distance from the scanner to the 
material below it. This can be done with a tape measure equipped with a weight on 
the end, or a laser. Record the distance measurement for further reference. 
Perform Grades Analysis, can be found under Tools menu. Once completed, the 
grades log window will pop up same as the Example of Grades Analysis log with FW 
3/4.x.x in page 42 . The horizontal axis refers to the distance (m or feet) of the echo 
from the scanner and the vertical axis refers to the power of the echo (there is no unit 
for power). 
You will then need to determine if the location of the echoes (vertical lines) are close 
to the manual measurement that was taken earlier. Note that the scanner is taking 
measurements of multiple points and may not match up with the manual 
measurement exactly.   
Let’s use this next image as an example.  We took a manual measure and the tape 
read 45ft. We are now comparing the Grades Analysis and we notice that there are 
echoes at the first 5ft. These are clearly false echoes and we will need to map them 
out. 

 
False Echo example in Grades Analysis window 

Zoom into the area of false echoes at the first 10ft by left clicking and dragging down 
and to the right marking a square around the required area. This is done to view the 
exact numbers that later needed to be mapped out under the False Echo Mapping 
function. 
False Echo mapping can be found under the Tools menu. We want to manually scan 
from 0 to beyond the distance of the false echoes. In this case we found it to be 6-7ft.  
Select Manual Scan, set the range of scan and the level of the threshold, in this case 
it can be 7000. Click the Start Scanning button and the word Calculating… will appear 
in the Threshold box. Once the fields are cleared the False Echo Mapping is 
completed. Wait couple of minutes and perform Grades Analysis again to verify the 
position of the False E. line (pink) in each of the beams the operation was done. Wait 
at least one damping time before the algorithm takes effect of the changes and 
completely ignores the false echoes. 

1 

2 

3 

4 

5 
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Note: This is a brief run through of the False Echo Mapping process. There are 
many other situations that may call for different techniques. An improper mapping 
of a vessel can lead to poor function of the 3DLevelScanner. 

Update Firmware… 
Uploads a new firmware to the device electronic card.  

 Click the […] browse button to select the APM file (*.ldr) to upload to the device. 
 Click Start Update to upload the file to the device. 
 Click Cancel Update to stop the update process. 
 Click Close to close the window. 

 
Update Firmware window 

 

IMPORTANT: Once the firmware update process is complete, reset the device to 
factory settings by clicking Reset to Factory Settings in Advanced Parameters… 
(F5), page 28. When using firmware version 3.x.x and above, it is not necessary 
to reset the device to factory defaults since all settings are done automatically. 
Downgrading a scanner firmware from version 4.x.x to older versions such as 
2.9.843 is not recommended and might reset the scanner’s polling address back 
to 00 and restore model type to S. On such operation, the scanner will return to 
its factory defaults and an upgrade to the original type will be necessary. Please 
contact APM Technical Support when facing such requirement. 

Upgrade Model… 
Upgrades or downgrades between S, M, MV, ML and MVL versions. 

 Select the relevant model to be upgraded to. 
 Click OK. 
 A password is required for upgrading to a higher model (M / MV / ML / MVL). The 

password can be supplied by your local distributor as a text file, or acquired from APM 
headquarters. Copy the password from the provided text file (license number) into the 
empty field in the dialog box. 
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Note: With correct license, the device will automatically reset and initialize itself. 

 
Upgrade model window 

Operating Mode 
 Standard Mode: In this mode, parameter modifications are disabled. Switching from 

Standard mode to other modes requires a password. 
 Technician Mode: In this mode, basic parameter modifications are enabled. A 

password is required. The password is ‘techAPM’.  
 Senior Technician Mode: In this mode, advanced parameter modifications are 

enabled. The password: ‘admin’ is required.  
 Debug Mode: A password protected development mode. Access is allowed only to 

APM development team. 
 Password is required only when moving to a higher level of operator. 

6.6 Help Menu 
The Help menu consist of two functions: 

Operation Manual  
Opens this document. 

About (F1) 
Opens the about window with version details. 
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Appendix A: End-User License Agreement  
Terms of Use & End User License Agreement 
This is a legal agreement between you, a user or purchaser of the Product (defined below) (the "End-User" or "You"), and A.P.M Automation 
Solutions Ltd. ("APM") regarding the software program accompanying this agreement and is a part of the 3DLevelScanner product of APM 
purchased by you (the “Product”), including the APM proprietary software program embedded in the Product (the “Software”), the hardware APM 
proprietary components of the Product (the "Hardware") and the Documentation (defined below). By opening the envelope in which the Software is 
provided and/or the package in which the Hardware is provided, by installing or by using the Software and/or the Hardware, You agree to be bound 
by all the terms of this Terms of Use & End User License Agreement (the "Agreement"). If You are obtaining an update of the Software from APM, 
then the term Software also includes, and the terms and conditions of this Agreement also apply to, any pre-existing Software and data provided 
within earlier Software releases, to the extent such earlier Software and data is retained by, embodied in or in any way used or accessed by the 
upgraded Software provided with this Agreement. APM IS WILLING TO SELL THE PRODUCT AND TO LICENSE THE SOFTWARE FOR 
OUR USE ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS AGREEMENT. If You do 
not agree to the terms of this Agreement, then please return the Product and the Software and any accompanying items to the place from 
which you obtained them. 
 
1. License. APM grants to End-User, a non-exclusive, non-transferable, non-sublicensable, personal license to install and use the Software for internal 
use by End-User at the site in which the Product was installed, together with the Hardware, and to use the text material that describes the design, 
functions, operation, and use of the Software (the “Documentation”) in support of End-User’s authorized use of the Software. 
 
2. Copy Restrictions. The Software, the design of the Hardware and the Documentation are protected by intellectual property laws and international 
treaty provisions. Unauthorized copying of the Software, the design of the Hardware and/or the Documentation, in whole or in part is expressly 
forbidden. Subject to these restrictions, End-User may (i) load the Software onto computer servers to support authorized use, and (ii) make one copy 
of the Software solely for backup, archive and disaster recovery purposes, provided End-User includes all copyright and trademark notices on the 
back-up copy. End-User may not copy any part of the Documentation, nor modify, adapt, translate into any language, or create derivative works based 
on the Documentation, the Software and/or the Hardware, without the prior written consent of APM. 
 
3. Ownership of the Software. APM retains all right, title, and interest in the Software, the design of the Hardware and the Documentation and any 
copy thereof, and reserves all rights not expressly granted to End-User. This License is not a sale of the original Software or of any copy thereof. 
 
4. Use Restrictions. (A) The Software is licensed to End-User for its own use only. The Software contains copyrighted material, trade secrets, and 
other proprietary materials of APM. End-User acknowledges that the scope of the license granted hereunder do not permit End-User (and End-User 
shall not allow any third party) to: (i) decompile, disassemble, decipher, reverse engineer or attempt to reconstruct, identify or discover any source 
code, underlying ideas, design, underlying user interface techniques or algorithms of the Software and/or the Hardware, by any means whatsoever, or 
disclose any of the foregoing; (ii) provide, distribute, rent, lease, lend, use for timesharing or service bureau purposes, or otherwise use, transfer or 
allow others to use the Product for the commercial or other benefit of third parties whether or not for consideration; (iii) modify, incorporate into or 
with other software, or create a derivative work of any part of the Software and/or the Hardware; (iv) disclose the results of any benchmarking of the 
Software, or use such results for its own development activities, without the prior written permission of APM; (v) attempt to circumvent any user 
limits or use restrictions that are built in to the Product; or (vi) sublicense, transfer or assign this Agreement or any of the rights or licenses granted 
under this Agreement and any attempt to do so shall be of no effect. End-User shall not remove, obscure, or alter APM's or third party suppliers’ 
copyright notices, trademarks, or other proprietary rights notices affixed to or contained on or within the Software. 
 
(B) For ATEX Compliant Products only: The Product is an ATEX compliant product. THE REMOVAL OF ANY COMPONENT OR THE 
ATTEMPT TO USE THE PRODUCT OR ANY PART THEREOF COMBINED WITH ANY NONATEX COMPATIBLE COMPONENT 
OR BY USE OF THE PRODUCT WITH ANY PART FROM A NON-ATEX COMPATIBLE COMPONENT OR WITH A COMPONENT 
THAT WAS NOT SUPPLIED WITH THE PRODUCT BY APM, MIGHT CAUSE DAMAGES TO THE PRODUCT, EXPLOSIONS, FIRE, 
DAMAGES TO OBJECTS IN THE VICINITY OF THE PRODUCT OR BODILY DAMAGES TO PERSONS IN THE VICINITY OF THE 
PRODUCT. 
 
For non-ATEX Compliant Products: The product is not ATEX compliant. The use of any part of an ATEX compliant Product with non-ATEX 
compliant Product constitutes infringement of the provisions of Section 4(A) above, and does not make in any way the non-ATEX compliant 
Product into an ATEX compliant Product, and MIGHT CAUSE DAMAGES TO THE PRODUCT, EXPLOSIONS, FIRE, DAMAGES TO 
OBJECTS IN THE VICINITY OF THE PRODUCT OR BODILY DAMAGES TO PERSONS IN THE VICINITY OF THE PRODUCT. 
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